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PC120 ETPRO FOR METDATA1, ET106, ET101, OR
WEATHER WATCH 2000 WEATHER STATIONS

ETPro is designed to calculate a potential evapotranspiration (ETo) value based on the Penman-
Monteith Equation as well as show current weather station conditions.  To use ETPro, PC208 software
must be installed on the computer (PC208 manual installation Section 1.2.1).  ETPro is contained on the
disk labeled ETPro disk 1 of 1.  The files on this disk must be copied to the directory where PC208
resides.  The menu file allows the user to program the weather station based upon the station’s
longitude, latitude, and elevation.  The user may select the type of communication (phone modem or
short haul modem) being used.  ETPro also allows monitoring real-time measurements, collecting data,
and generating reports from an easy-to-use software working environment.

NOTE:  Time zone coordinates are vital in accurate ETo calculation.  A time zone map (Figure 1) is
provided for use in determining in which time zone the weather station is located.

1.  SOFTWARE INSTALLATION

Insert the ETPro disk into drive A or B of the
computer.  Copy all files from this disk to the
same directory where PC208 resides.

For example, if the ETPro disk is in drive A and
the directory where the PC208 software resides

is C:\PC208, then move to the C:\PC208
directory.  From the C:\PC208> prompt, type
“copy a:*.*” and press <Enter>.  All files will be
copied from the A drive to the C:\PC208
directory.
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FIGURE 1.  Time Zone Map
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2.  THE ETPRO SHELL

1. Move to the directory where the ETPro files
are located.  From the DOS prompt, type
“et” and press <Enter>.  The screen that
appears should look like Figure 2.  This
screen is referred to as the ETPro shell, or
simply as the shell.

NOTE:  DO NOT run the shell from
Windows 3.1.  The shell could act
erratically.  Make sure Windows 3.1 has
been completely shut off and that the shell
is running purely through DOS.

2.1  MOUSE OR KEYBOARD OPERATION

Menus and sub-menus can be selected by
clicking on them once with the left mouse
button.

If a keyboard is used, press the <Alt> key.
Notice a specific letter will change color in each
of the menus.  To activate a particular menu,
press the letter on the keyboard that matches
the color-changed menu letter or press the right
or left arrow key to move to the appropriate
menu and press <Enter> to select it.

The sub-menus will automatically come up with
a color-changed letter once the main menu item
has been selected.

For individual selection, press the matching
letter on the keyboard or use the up and down
arrow keys to move to the appropriate sub-
menu and then press <Enter> to select it.

2.2  THE FILE MENU

2.2.1  “About” Sub-menu

A brief description of ETPro will appear by
selecting the “File” menu and the ”About” sub-
menu.

2.2.2  Exiting ETPro

ETPro will exit to the DOS prompt by selecting
the “File” menu and the “Exit” sub-menu.  This
is the way to exit out of ETPro.

2.3  CREATING THE WEATHER STATION
PROGRAM

1. Select the “Edit” menu and the “Create
Station Program” sub-menu from the shell.

2. A window will appear welcoming you to
ETPro and asking whether you have a color
monitor.  Default is “Y”.  Press <Enter>if
you have a color monitor.

Type “n” or “N” and press <Enter> if you do
not have a color monitor (monochrome
display).

FIGURE 2.  ETPro Shell
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3. The next window should appear similar to
Figure 3.  The default settings are as
follows with alternate selection in
parenthesis:

Weather Station Model:  MetData1
(ET106, ET101, Weather Watch 2000)

Enclosure Relative Humidity Sensor:
Yes (No)

Soil Temperature Probe:  N (Y)

ETo Calculation:  Y (N)

Weather station model can be changed by
either clicking on the entry with a mouse or
by using the up or down arrow keys on the
keyboard to move to the correct entry and
pressing <Enter> to select it.  The small box
at the bottom of this window has a brief
explanation on the entry being selected.

Selecting a particular station model will also
bring up the default sensor array for that
station in the sensor units selection window.

NOTE:  The “Enclosure Relative Humidity
Sensor” entry can only be changed from
within the “Weather Station Model” entry.
The “Enclosure Relative Humidity Sensor”
will default to “Yes” if the MetData1, ET106,
or ET101 weather station is selected.

To change “Soil Temperature Probe:” or
“ETo Calculation:” a “Y”, “y” or “N”, “n” must
be entered from the keyboard into the
appropriate box.

Selecting no ETo calculation will set the 24
hour data collection at midnight.

4. Sensor units can be viewed or changed by
selecting the “Sensor Units” entry.  A
window should appear similar to Figure 4.

FIGURE 3.  Program Development
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FIGURE 4.  Sensor Units Selection

NOTE:  If a W2000, ET106, or ET101
weather station is being used, it MUST have
the same type of sensors as described in
this window.  The program generated by
this part of ETPro is based on a specific
sensor array.  You will need to manually
make changes to the program after it has
been created using ETPro if you are using a
different complement of sensors.  SEE
APPENDIX B FOR INFORMATION ON
CUSTOMIZATION.

The right side of the sensor units window
indicates the values that are being saved to
hour (60 minutes) and 24 hour (1440
minutes) final storage.

The box in the lower, right-hand corner of
the sensor units window gives a brief
explanation on entries being selected.

5. Default sensor selections for the individual
weather stations are as follows:

METDATA1
Temp/%RH - HMP45C
Wind Speed and Direction - Met One 034A
Solar - LI200X
Precipitation - TE525
Soil Temp - 107 (if used)

*ET106
Temp/%RH - CS500
Wind Speed and Direction - Met One 034A
Solar - LI200X
Precipitation - TE525
Soil Temp - 107 (if used)

*ET101
Air Temp - CS200
Wind Speed and Direction - Not Applicable
Solar - LI200X
Precipitation - Not Applicable
Soil Temp - 107 (if used)

*W2000
Temp/%RH - HMP35C
Wind Speed and Direction - RM Young
Wind Sentry 03001
Solar - LI200X
Precipitation - TE525
Soil Temp - 107 (if used)

*Except for the soil temperature probe
these stations are preconfigured and
shipped with this set of sensors.

NOTE:  Only select different sensors when
you are certain of what your particular
station is using.  Selecting the incorrect
sensor can result in incorrect
measurements by the weather station.

6. Latitude and Longitude will require knowing
whether the site is North or South of the
equator for latitude (for example, a site in
Logan, Utah would be 41.784° N), and
whether the site is East or West of the
Greenwich Meridian for longitude (for
example, the same site in Logan, Utah
would be 111.85° W).  These entries must
be entered in ETPro as decimal degrees
NOT degrees - minutes - seconds.
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NOTE:  The location of the site must be
known within a degree for both latitude and
longitude for accuracy in the ETo
calculation.

7. Elevation can be entered as feet or meters.

NOTE:  The elevation of the site must be
known within a hundred feet (30 meters)for
accuracy in the ETo calculation.

8. Once all the sensor models and units have
been entered, select “Done” to go back to
the first ETPro program development
screen (Figure 3).  Press the <F4> key to
create the weather station program as well
as several other files used by ETPro.
Depending on the computer, it might take
several minutes for this part of program
creation to finish.

NOTE:  See Appendix B.1 for a listing of all
the files created.

A window will appear that explains how long the
datalogger will collect data before it begins
overwriting old data.  These numbers are for a
standard CR10.  This number can be doubled if
the weather station is using a CR10X.

A number will also appear that relates to the
time the datalogger clock is set in relation to
Greenwich time.  THE DATALOGGER MUST
BE SET TO STANDARD TIME.  If you are in
doubt whether you are on standard or daylight
savings time, call NIST at (303) 499-7111,
which is a recording of universal time.  Once
each minute you will hear the current universal

time local to Greenwich, England.  With this
time you can refer to the time zone map (Figure
1) and count back the number of hours you are
from Greenwich.  For example, Logan, Utah is -
7 hours from Greenwich.  Therefore, if the time
heard was 1500 hours, the proper time at the
station is 1500 - 7, or 8:00 A.M.  Set the
computer that will be communicating with the
weather station to this time.

Press the <Enter> key to return to the shell.

2.4  SETTING UP COMMUNICATION

1. Select the “Edit” menu followed by the
“Communication Param.” sub-menu from
the shell.

2. A window will appear as shown in Figure 5.
A mouse will not work in this window.  Use
the up and down arrow keys to move
around.

3. Notice the COM Port being used.  Default is
COM1.  If your computer is using some
other COM Port, move the cursor down to
COM1 and press the <space> bar until the
proper COM Port appears.

4. Communications baud rate can be left at
9600 for RAD short haul modem.  For
phone modem, change the baud rate to
1200 baud by moving the cursor to this
section and pressing the <space> bar until
1200 appears.

5. Move the cursor below the line that says
“Interface Device”.  It will come up with “#1:
End”.  If a RAD modem is being used,
press the <space> bar until “RAD Modem”
appears.
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FIGURE 5.  Communication Parameters

If a phone modem is being used, press the
<space> bar until “Hayes Modem” appears.
Press the <Enter> key and type in the correct
phone number for the weather station.  You
may need to modify the MODEM.INI file in the
PC208 directory to work with your particular
phone modem or make some other changes to
accommodate your modem.  SEE THE PC208
MANUAL FOR FURTHER ASSISTANCE.

Press <Enter> after RAD Modem or Hayes
Phone Modem with the phone number has been
selected.  “#2: End” should appear on the
screen.  To save the entries, press and hold
down the <Ctrl> key, press the <P> key, and
release both keys simultaneously.

2.5  DOWNLOADING THE PROGRAM TO THE
WEATHER STATION

1. The program can be downloaded after the
weather station has been installed and
powered up.  Make sure the computer clock
is set to the correct date and standard time.

Select the “Maintenance” menu option
followed by “Download Station Program”
from the shell.

2. Click with a mouse the button marked “OK
to set clock” or tab over to it and press the
<Enter> key to select.

The computer screen will change to yellow
lettering on a black screen.  There is no
communication going on between the computer

and the weather station if the cursor just blinks
in the upper left hand corner.  SEE THE
WEATHER STATION INSTALLATION
MANUAL FOR COMMUNICATION
TROUBLESHOOTING TIPS.

The screen should begin to fill with “220 bytes
sent, received, entered.”

This indicates the program is being sent to the
weather station.  Eventually this will stop and
the screen will return to the shell.

NOTE:  It’s a good idea to go into monitor
mode after a program has been
downloaded.  There will not be any hourly
values until the top of the hour, or 24 hour
values until the time that was set for the 24
hour data storage to take place.  You may
have to wait as long as 20 seconds before
sensor values appear.

WARNING:   The data that was previously
stored in the datalogger will be lost if a
program is accidentally downloaded to a
station that is already running.  Keep this in
mind if you are planning on making
changes to an existing program and
downloading the new program to a station
that is already running.
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2.6  SETTING THE CLOCK ON THE WEATHER
STATION

1. The weather station’s clock is more
accurate than the clock in most computers.
Make sure the time and date on the calling
computer is correct and set to standard
time if the weather station clock is definitely
incorrect.

2. Select the “Maintenance” menu followed by
the “Set Clock” sub-menu from the shell.

3. Click on “OK to set clock” with a mouse or
press the <Enter> key.  This will
automatically call the weather station and
set the date and time.

2.7  REAL TIME WEATHER STATION
MONITORING

1. Select the “Data” menu and the “Monitor”
sub-menu from the shell.

2. The computer will call the weather station
and a screen similar to Figure 6 should
appear.

The values in the left column are updated
every 10 seconds; the values in the center
column are updated on an hourly basis; and

the values in the right-hand column are
updated every 24 hours at the time that was
set while creating the program.

3. Press the <Esc> key to exit weather station
monitoring.  The program will return to the
shell.

2.8  COLLECTING DATA FROM THE WEATHER
STATION

1. Select the “Data” menu and the “Collect
Data” sub-menu from the shell.

2. The computer will call the weather station,
collect data to a file called
“WEATHER.DAT”, and return to the shell.

NOTE:  The WEATHER.DAT file gets data
appended to it every time the station is
called.  This file will continue to grow every
time the weather station is called and data
is uploaded to the computer.  It is advisable
to archive this file once a year to a separate
floppy disk that is marked with the start and
stop date for the data file and delete the old
data file off of the computer’s hard drive.
The weather station will automatically
create a new WEATHER.DAT file the next
time it is called.

FIGURE 6.  Weather Station Real Time Monitoring
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2.9  REPORTS

2.9.1  Hourly Reports

1. Select the “Reports” menu followed by the
“Hourly Summary” sub-menu from the shell.
A screen should appear similar to Figure 7.

2. The various start and end conditions can be
selected by clicking on them with a mouse or
pressing the <Tab> key to move to the
correct condition.  The condition can be
changed by using the <Delete> key or the
<Backspace> key.  Type in the correct start
and end conditions.  Time must be entered
in 24 hour hourly increments.  For example,
2:00 P.M. would be entered as 14.

WARNING:   The start condition must exist
in the data set or no report will be
generated.  For example, if the
WEATHER.DAT file starts with data from
8/11/1995 @ 17:00 hours and 16 is
selected as the start hour, then NO report
will be generated even though there is data
after this time period.

NOTE:  The report generator will stop and
NOT report on the end condition specified.
For example, to see data up to 2:00 P.M.
today, enter 15 (3:00 P.M.) as the end hour
condition.  An end condition can be entered
that doesn’t exist and the report will still run.
While the report is being generated, a
warning message will flash at the top of the
screen.  Press the <Esc> key to get past the
message and finish generating the report.

“Report Destination” specifies whether the
report should go to the screen to be viewed
or to the printer for a hard copy.  Click with a
mouse between the parentheses to specify
which one you want or move to this section
using the <Tab> key and use the right and
left arrow keys to select which one you want.

3. After all the start and end conditions have
been entered and the report destination is
set, click on the “OK” button or tab over to
“OK” and press <Enter> to run the report.

The screen will change and at the top of the
screen numbers will appear and run by.  The
larger the WEATHER.DAT file, the longer it will
take the report to be generated for recent data.

The <Page Up> and <Page Down> keys can be
used to view the entire report if the report was
sent to the screen.  Press the <Esc> key to exit
the report and return to the “Hourly Summary
Report” window.

FIGURE 7.  Hourly Summary Report
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ETPro will automatically insert page numbers
and page breaks into the report if the report was
sent to the printer.

ETPro will return to the “Hourly Summary
Report” screen after the report has been run.
Select “Cancel” to return to the shell.

A file called “HOURLY.PRN” will be generated
by ETPro and put on the hard drive in the same
directory where ETPro resides.  This file is a
simple field formatted ASCII text file and can be
imported into a spread sheet package.

Columns in the reports can be modified.  If this
is required, see Appendix B.

2.9.2  Daily Reports

1. Select the “Reports” menu followed by the
“Daily Summary” sub-menu from the shell.
A screen should appear similar to Figure 8.

2. The various start and end conditions can be
selected by clicking on them with a mouse
or pressing the <Tab> key to move to the
correct condition.  The condition can be
changed by using the <Delete> key or the
<Backspace> key.  Type in the correct start
and end conditions.

WARNING:   The start condition must exist
in the data set or no report will be
generated.  For example, if the
WEATHER.DAT file starts with data from
8/11/1995 and 10 is selected as the start
day, then NO report will be generated even
though there is data after this time period.

NOTE:  The report generator will stop and
NOT report on the end condition specified.
For example, to see data up to the fifth day
of the month, enter six as the end condition.
An end condition can be entered that
doesn’t exist and the report will run.  While
the report is being generated, a warning
message will flash at the top of the screen.
Press the <Esc> key to get past the
message and finish generating the report.

“Report Destination” specifies whether the
report should go to the screen to be
reviewed or to the printer for a hard copy.
Click with a mouse between the
parentheses to specify which one you want
or move to this section using the <Tab> key
and use the right and left arrow keys to
select which one you want.

3. After all the start and end conditions have
been entered and the report destination is
set, click on the “OK” button or tab over to
“OK” and press <Enter> to run the report.

FIGURE 8.  Daily Summary Report
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The screen will change and at the top of the
screen numbers will appear and run by.  The
larger the WEATHER.DAT file, the longer it will
take the report to be generated for recent data.

The <Page Up> and <Page Down> keys can be
used to view the entire report if the report was
sent to the screen.  Press the <Esc> key to exit
the report and return to the “Daily Summary
Report” window.

ETPro will automatically insert page numbers
and page breaks into the report if the report was
sent to the printer.

ETPro will return to the “Daily Summary Report”
screen after the report has been run.  Select
“Cancel” to return to the shell.

A file called “DAILY.PRN” will be generated by
ETPro and put on the hard drive in the same
directory where ETPro resides.  This file is a
simple field formatted ASCII text file and can be
imported into a spread sheet package.

Columns in the reports can be modified.  If this
is required, see Appendix B.
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APPENDIX A.  MAIN MENU OVERVIEW

A.1  BRIEF EXPLANATION OF
HEADINGS

ETPro has five main menus:  File, Edit,
Maintenance, Data, and Reports.

A.2  FILE

About
Exit

ABOUT:  Shows the version number and
provides a brief description of ETPro.

EXIT:  Exits the ETPro shell and returns to
DOS.

A.3  EDIT

Create Station Program
Communication Param.

CREATE STATION PROGRAM:  Generates the
program for the weather station based on user
inputs and selections.  By default, sensor units
are in SI units.  Press F1 in this program for
help.

COMMUNICATION PARAMETERS:  Creates
unique weather station communication
parameters based on user input.  This section is
used to define whether the station is using a
RAD short haul or a phone modem for
communication.

A.4  MAINTENANCE

Set Clock
Download Station Program

SET CLOCK:  Sets the weather station clock to
the time on the calling computer.

DOWNLOAD STATION PROGRAM:  Sets the
weather station clock to the time on the calling
computer as well as downloads the program to
the weather station created in the “Create
Station Program” explained in Section 1.2.2.2.

A.5  DATA

Monitor
Collect Data

MONITOR:  Allows the user to monitor real time
weather station data.

COLLECT DATA:  Retrieves the hourly and
daily data from the weather station.

NOTE:  Data collection IS NOT automatic.  The
“Collect Data” sub-menu item must be used in
order to collect the most recent data.

A.6  REPORTS

Hourly Summary
Daily Summary

HOURLY SUMMARY:  Creates a user defined
time period report based on hourly weather
station data.

DAILY REPORT:  Creates a user defined time
period report based on daily weather station
data.
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